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Slope Stability
Alessio FERRARI (AF)

Exercise 4b
LEM software application
EXERCISE AND TUTORIAL OF GEOSTUDIO SLOPE/W

Introduction

Similarly to Exercise 4a, the goal of this exercise is to perform slope stability analyses by using the
commercial software GeoStudio 2018 (student version). Let F(s;) the safety factor computed for a
specific surface si. By considering that the actual failure surface is unknown, a certain number of
potential failure surfaces s needs to be considered. The actual safety factor is defined as F = min;

{F(si)}.

GeoStudio 2018 can be downloaded at the following website:
https://www.geoslope.com/learning/downloads/alternate-downloads. A tutorial is presented in section
1.2 in order to guide the student through the basic steps of GeoStudio. The tutorial refers to the
GeoStudio 2018 version (if you would like to download a newer version there might be some small
differences compared to this tutorial but it should be quite easy to understand them).

1.1 Exercise description

In this exercise, the stability of a cut and fill is analyzed. The geometry and soil properties are recalled
in Figure 1 and Table 1. The soil is considered dry. In the following tutorial, coordinates to define the
slope geometry will be also given.
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Figure 1: “Cut and fill” slope geometry.

Table 1: geometry and soil properties of the slope reported in Figure 1.

Material 7w (kN/mM3) | @ (°) | ¢ (kPa)

Silty sand 18 32 6
Sandy clay 16 18 10
Slope

goometry | @) | HE | Ham) | L)

41.3 10 16 6

For the proposed slope configuration, evaluate the factor of safety F = min; { F(si) } by adopting
GeoStudio™ SLOPE/W. Subdivide the slope in a number of slices equal to 40 and perform the
stability analyses by using the simplified Bishop’s method and the Morgenstern-Price method. For
identifying the circular slip surfaces it is suggested to use the Grid and Radius method.

Write in Table 2, for the dry conditions and for each applied method, the results of the analyses in
terms of:

- safety factor F;
- characteristics of the failure surface (coordinate of the center C and radius r).

Make final comments on the obtained results. Can the slope be considered stable? Consider
satisfactory a safety factor F > 1.3 to keep into account uncertainties due, for example, to the
estimation of the geotechnical parameters. In discussing the results, distinguish between superficial
and deep failure mechanisms.

Table 2: summary of results obtained by using GeoStudio SLOPE/W.

BISHOP simplified | MORGENSTERN-PRICE

“Cut and fill” (Xc; yc)= (Xc; ye)=
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1.2 GeoStudio™ SLOPE/W tutorial

In the following sections a step-by-step tutorial is presented to solve the proposed problem; three
main steps will be accomplished:
1. apre-processing phase, where all the input data are introduced (geometry, material properties,
type of analysis...);
2. a processing step, in which the problem is solved with the Limit Equilibrium Method
according to the selected approach (i.e. simplified Bishop’s method or Morgenstern-Price
method);

3. apost-processing step, in which the obtained results are displayed and analyzed.

To indicate a command, the notation '‘Menu—->Submenu—>Command' is used.
Launch GeoStudio™ 2018 (‘Démarrer->Programmes—> Programmes GC->GeoStudio 2018°).

For creating a new project select SLOPE/W project as show in Figure 2.

@ GeoStudio 2018 [STUDENT] -_

File Edit View Window Help

DE | &0 n

oy
.

K@ GeoStudio 2018student license

Select Template

Imperial - A4

Select Analysis

< SEEP/W
SIGMA/W
44 QUAKE/IW
< TEMP/W
P CTRAN/W

A AIRIW

Figure 2: GeoStudio™ 2018 starting interface.
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It is suggested to choose the basic units of measurements: ‘View—> Units’ (Figure 3).

£ Units B %

Base Units

Time:
Length:

Temperature:

Derived Units

["] only show modified display units

Category Units -

Acceleration m/sec? |: | -
Air Mass kg

Air Mass Flux ka/sec/m2 -
Air Mass Rate ka/sec

Air Volume m3 M
Air Volume Flux m3/sec/m? -
Air Volume Rate m3/sec

Area m2 -
Climate Volume Flux m3/sec/mz -
Compressibility [kPa -

4| I |

Figure 3: Units window.

The Grid spacing can be changed by using the command ‘View—> Grid’ (Figure 4).

-)I Grid Pl X

Grid spacing
X: 0.1m

s 0.1m

Display grid
Snap to grid
Display axis lines

Figure 4: Grid window.

Afterwards, save the project in your working folder: namefile.gsz, as a GeoStudio file (*.gsz).
Remember to save regularly your project (File—> Save).
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Pre-processing step, geometry and material

Define analysis: settings

For defining the options of the analysis to be performed, use the “Define Analyses” interface by
following the path: ‘Define—> Analyses’.

T — - - = = -
| &2 Define Analyses - L L B . 7 - | [ |
q . Description:

Analyses: Delete Name: SLOPE/W Analysis

[=-4@ (untitled) > -
Analysis Type: [B\shup ) V]
—

Settings | Slip Surface | Distribution |Advanced‘
\

1 ‘ PWP Conditions from: I(none) 3 V]

Staged Pseudo-static analysis:
1 [[none) V|
1
. Partial Factors:

(none) ) [

Unit Weight of Water: 9.807 kN/m3
I

Figure 5: Define Analyses interface.

The method for performing the analysis can be chosen: ‘Define> Analyses = Analysis
Type->Bishop’. For the current study, the pore water pressure conditions are not kept into account:
‘PWP conditions from—>(none)’ (Figure 5).

Define analysis: Slip surface

‘Define=> Analyses = Slip surface’

The direction of movement has to be defined, according to Figure 1, going from ‘right to the left’. A
‘Grid and Radius’ slip surface option is set (Figure 6). It means the potential slip surfaces will be
defined during computation with a grid of possible centers of rotation and a series of parallel lines
tangential to slip surfaces.
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[ [— L
42 Define Analyses _ ' E -
.
. ; Description:
Analyses: Delete . Name: SLOPE/W Analysis

E-49 (untitled)

Parent: ‘(nnne] V‘ -
| I SLOPE/ W Analysis|
Analysis Type: [Blshup -
Settings | Slip Surface | Distribution | Advanced|
Direction of movement
OLeﬁ to right @Right to left Use passive mode
Slip Surface Option
- . Mo, of critical slip
() Entry and Exit surfaces to stare;
l I:‘Spacify radius tangent lines
(| (@) Grid and Radius Optimize critical slip surface location
l ‘f_'EIack Specified

I:‘Do not cross block slip surface lines
‘T_'Fu\ly Specified

O Critical Slip Surfaces from:

Tension Crack Cption

. Water in Tension Crack
(@) No tension crack

- Filled with water (00 13:
() Tension crack angle: I:I Unit wsight of watsr %

() Tension crack line

= . |

Figure 6: Slip surface window.

Define analysis: distribution
‘Define> Analyses = Distribution=> Constant’
GeoStudio 2018 with Student license allows only a constant F distribution calculation (Figure 7).

 Deine e | T R Y T TR SR e L
S -
Description:
M 3 SLOFI Anal
Analyses: Delele . Name: E/W Analysis

=48 (untitled)
B8 N SLOPE/ W Analysis|

i Analysis Type: Iishop -
Settings | Slip Surface  Distribution | Advanced |

Factor of Safety Distribution Calculation

Parent: |(none] v|

@ Constant

(7) Probabilistic

‘ Set Probabilistic Parameters... |

# of Monte-Carlo Trials: 2,000

[ use spatial variation

() sample each Slice

(T use Sampling Distance: D

() Sensitivity

‘ Set Sensitivity Parameters...

Figure 7: Distribution window.
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Define analysis: Advanced
‘Define> Analyses - Advanced-> Number of slices>40° (Figure 8).

@ Define Analyses O *
Add - Delete Mame: | SLOPE/W Analysis Description:
Analyses: fay ‘ :
=A@ esercizio (none) ‘
...... SLOPE/W Analysis
- Analysis Type: Bishop v
Settings  Slip Surface  Distribution  Advanced
Geometry Settings:
Minimurm slip surface depth: 0.03048 m
Mumber of slices:
Factor of Safety Convergence Settings:
Maximum number of iterations:
Tolerable difference in F of S:
Undo |+ Redo [+ Close

Figure 8: Advanced window.

Afterwards, save the project in your working folder: namefile.gsz, as a GeoStudio Compressed file
(*.gsz). Remember to save regularly your project (File->Save).

Define geometry

The command ‘Draw->Regions—>Polygonal’ allows the geometry to be defined manually (Figure 9).
Then, the ‘Enter coordinate’ cell in the bottom left can be used for this purpose. Starting from the
origin O, referring to the given geometry (Figure 1), the following points must be added: (0;0),
(11.4;10), (17.4;10), (28.8; 20), (50;20), (50;0) and reconnect the last point to the origin (0;0).
Subsequently draw the second region as follows: (50;0), (50;-16), (-30;-16), (-30;0), (50;0). Finally
draw the bottom layer corresponding to the rigid bedrock. Would you expect that the thickness of
such last layer would influence the problem?

Afterwards, the axes of the reference system can be displayed by setting their minimum and
maximum values of interest: ‘Sketch—>Axes’.
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. o)
-) Draw Regions ] P
Draw Domain Region: Floating Region:
@) Polygonal Circular Polygonal
Draw a new polygon region.
Hold the Ctrl key to snap along an existing boundary.
Undo - Redo -
Figure 9: Draw regions window.
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Figure 10: Geometry according to Figure 1 and Table 1.

Define and assign materials

The command ‘Define—>Materials’ allows defining the properties of the materials. For the case under
study, select Mohr-Coulomb material model and write the basic information of the soils according to
the given data (Table 1).
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td Define Materials O X

Materials
Mame Caolor Add -
BedRock [
Sancy cay — T
Silty sand L 1]
Assigned...

Mame:
BedRodk
Slope Stability
Material Model: Bedrock {Impenetrable) hd
Undo |+ Redo |~ [ show legend Properties. .. Close

Figure 11: Define materials window.

The defined material can be assigned to the specific region of interest. For the case under study, the
defined material has to be assigned to the corresponding domain. In order to assign the material do
‘Draw —> Materials > Assign’ and select the respective domain. If the assignment is successful, the
region is colored with the color corresponding to the chosen material (Figure 12).
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Figure 12: material assignment.
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Definition of the possible failure surfaces
The centers of rotation of the circular surfaces and the lines that control the slip surface radii can be
selected by using the command ‘Draw slip surface grid’ and ‘Draw slip surface radius’ from the

command bar (Figure 13 and 14).

@ 1% - GeoStudio 2018 [STUDENT] (SLOPE/W Definition)

Fle Edit View Define Draw Sketch Modify Window Help
NG H @|ana-e 3 FPEYEDOD| —[F-
:;'_‘}Resuhs [ Page Layout Iy ﬁ| 3|§/ |++] ﬁ’\f|y’ & i
& Solve Manager | <l . SLOPEW An.. [v] ¢

LY R A A
Yk k| ME oo

Figure 13: Draw slip surface grid.

4@ 1* - GeoStudio 2018 [STUDENT] (SLOPE/W Definition)

Fle Edit View Define Draw Sketch Modify Window Help
NGB an 9003 YEEEYDHO| _F2-EY R
(e st | B oseraro & TR By # |1 £ 1l X | 2| £ Ve 1 e | @B oo
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Figure 14: Draw slip surface radius.

Note that the grid must be defined by first clicking on the Upper-Left corner, then the Lower-Left
corner and finally the Lower-Right corner.

A possible configuration of the grid and of the tangent lines is given in Figure 15.

O SR RSRRERERTS
R O e T,
% “““‘“\‘“‘“3‘:“\“‘:““3“‘

%
R I R

O “‘ ‘ ‘/.“
>

Elevation
Elevation

Distance

Figure 15: grid and radius definition.
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Processing step
The processing step can be performed by launching the Solve Manager.

Post-processing step

At the end of the computation step, the interface automatically turns in the ‘Results’ mode: the
‘Definition’ button is de-selected. This is the post-processing interface of SLOPE/W which allows
displaying and analyzing the results. For identifying the critical slip surface and analyzing the safety
factors values follow the path: “Window > Slip Surfaces’. For setting the options of the Color Map
(change colors, show the legend...), select the bottom ‘Draw slip surface color map’ on the command
bar (Figure 16).

<@ Draw Slip Surface Color Map l @ . S

Factor of Safety Range: 1.195 to 171.135

Starting Value: @) Min F of S I set.

1.000 |W\de Rainbow - ‘

Increment by: 0.100 i

Number of Colors: 10 U

Ending Value: 2.195 [ ] Set.

V| show legend Properties... Close
e —

Figure 16: Draw slip surface color map window.

Several failure surfaces need to be analyzed iteratively in order to identifying the one which
correspond to the minimum safety factor value (the corresponding failure mechanism should also be
shown to be significant in terms of involved volume of soil).

In Figure 17 the expected critical failure surface according to the simplified Bishop method is shown.
As last prescriptions for the current tutorial, remember to change the analysis mode for the
Morgenstern-Price method through the interface reported in Figure 5 keeping the half-sine function
as default settings (‘Keyln Analysis>Analysis type—> Morgenstern-Price’ and ‘Keyln
Analysis—> Settings—> Side function->Half-sine function’).
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Figure 17: iso-F contour map and slip surface map according to the Bishop simplified method.

Conclude the Exercise by filling in Table 2 with the calculated factors of safety and the geometrical
characteristics of the corresponding critical slip surfaces. Then, answer the questions given on page
2.
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